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Micro Focus COBOL Server 2.2 Release
Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

Product
Overview

COBOL Server provides the execution environment for applications created with Micro
Focus Visual COBOL.

The product is available in the following variants which you can install and use with the
same license:

• COBOL Server which is the deployment environment for COBOL applications
created with Visual COBOL for Visual Studio 2010 or Visual COBOL for Eclipse.

• COBOL Server 2012 which targets applications created with Visual COBOL for
Visual Studio 2012.

Compiling for
COBOL Server
or for COBOL
Server 2012

Visual COBOL for Visual Studio 2010 and Visual COBOL for Visual Studio 2012 each
target a different version of the COBOL run-time system - COBOL Server and COBOL
Server 2012, respectively.

Ensure that, after you've edited the project in the preferred version of Visual Studio, you
compile your source code in that version of Visual COBOL which targets the version of
the COBOL run-time in which you want your applications to run.

For example, if you build your application using Visual COBOL for Visual Studio 2010
you cannot deploy the target files to COBOL Server 2012, you must use COBOL Server.

Note: Visual COBOL now includes support for creating Web service and Enterprise Java Bean
applications using the Interface Mapping Toolkit (IMTK) in conjunction with Enterprise Server. If you
are upgrading to this release from an earlier version of Visual COBOL, you may need to apply for a
new authorization code in order to access the functionality - please contact Micro Focus SupportLine
to receive an updated authorization code. Note that the Visual COBOL Personal Edition license does
not support the IMTK functionality.
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Installation

Installing on Windows

System Requirements for COBOL Server for Windows

Hardware Requirements
The disk space requirements are approximately:

Platform COBOL Server Sentinel RMS License Manager

x86 Windows platforms 190MB 35MB

x64 Windows platforms 290MB 35MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
The following platforms are supported:

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• COBOL Server 2012 is not supported on versions of Windows earlier than Windows 7.

Software Requirements
Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

Before installing this product, you must have the following software installed on your computer:

• The Microsoft .NET Framework - the setup file installs Microsoft .NET Framework 4 with COBOL Server
or .NET Framework 4.5 with COBOL Server. You might need to install the following version of the .NET
framework manually, if it is targeted by your applications:

• Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.

To download the Microsoft .NET Framework 2 click here.

Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.

• Microsoft .NET Framework 4.5 might be required for COBOL applications created with Visual Studio
2012.

Note:

• .NET Framework 3 is provided with Windows Vista and Windows Server 2008.
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• .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
• Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up

ASP.NET. To download the installer click here.

• The Java Development Kit (JDK), version 1.6 (u27 or later) or version 1.7 (u05 or later), is required for
compiling Java. The JDK is downloadable from www.oracle.com. After installing the JDK, you must put
the tools.jar file for the JDK on your classpath, using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

• A Web browser is required for Enterprise Server Administration in COBOL Server.

To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric
equivalent (127.0.0.1).

• To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems. Also, active
content must be allowed and not blocked. To enable both these in Internet Explorer:

1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click

Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active

content to run in files on My Computer is checked.
• Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable

the Search facility to work.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file. The following information specifies the third-party software required for each feature.

Java Compilation

• The Java Development Kit (JDK), version 1.6 (u27 or later) or version 1.7 (u05 or later), is required for
compiling Java. The JDK is downloadable from www.oracle.com. After installing the JDK, you must put
the tools.jar file for the JDK on your classpath, using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

XML Extensions

• XML Extensions has the same requirements as Visual COBOL. Both 32-bit and 64-bit versions are
available. See the Visual COBOL XML Extensions User's Guide, available from the Visual COBOL
product documentation section of the SupportLine website, for more details.
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• Additionally, XML Extensions may be used in conjunction with Terminal Server.

Database Access

Before you can use COBOL Server to deploy SQL applications developed with OpenESQL, DB2 ECM, or
COBSQL, ensure any third-party software prerequisites are installed and the environment is set properly.
Refer to the your product help, Welcome > Product Information > Installing... > System
Requirements... > Additional Software Requirements > Database Access, for details.

Java Development Kit (JDK)

The Java Development Kit (JDK) is required for compiling Java.

JDK or JRE is required for compiling and running COBOL JVM applications

After installing the JDK, you need to set up your Java environment.

Installing COBOL Server for Windows

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Product Co-Existence
• COBOL Server comes in the following versions:

• COBOL Server 2010, which is the deployment server for applications built using Visual COBOL for
Visual Studio 2010 and Visual COBOL for Eclipse.

• COBOL Server 2012, which is the deployment server for applications built using Visual COBOL for
Visual Studio 2012.

You can only deploy applications to the version of COBOL Server from the associated development
product you used to build the applications. For example, if you built your application using Visual
COBOL for Visual Studio 2012 you must deploy the target files to COBOL Server 2012.

• COBOL Server 2010 and COBOL Server 2012 cannot coexist on the same machine.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:

• If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
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2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open a  COBOL Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Installing
These are the steps to install this product:

1. Run the cs2010_22.exe file and follow the wizard instructions to install the prerequisite software and
the product.

Note: If you are installing COBOL Server 2012, the file you need to use is cs2012_22.exe.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove
Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with COBOL Server but you can install it if you wish.

Installing as an Upgrade
This release will update an existing installation of COBOL Server versions 2.1 or 2.1 Update 1.

Before installing, check Installation Restrictions and Requirements.
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COBOL Server Installation Options
To install COBOL Server you run cs2010_22.exe which contains a number of product .msi files
(Windows Installer packages). When run, cs2010_22.exe performs some initial system checks then
sequentially installs the .msi files.

Note: The name of the installable executable in this document is always the name of the executable
for COBOL Server - this is cs2010_22.exe for COBOL Server and cs2012_22.exe for COBOL
Server 2012.

cs2010_22.exe can take a number of parameters, enabling you to specify a number of different types of
installation:

• Standard Installation

Format:
cs2010_22.exe

Summary:
Full installation including License Manager and COBOL Server. During installation you can specify
options including the location to which the components are installed.

• Non-interactive Installation

Format:
cs2010_22.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
cs2010_22.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
cs2010_22.exe /q InstallFolder=d:\cobolrts

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
COBOL Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line: cs2010_22.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

After Installing
To open the help on versions of Windows 7 and earlier, select Start > All Programs > Micro Focus
COBOL Server > Documentation from the Windows Taskbar.

On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available links
for this product. In the COBOL Server section, click Documentation.
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This starts the documentation for COBOL Server in the online Micro Focus Infocenter. From the left hand
pane, select Micro Focus Developer > Micro Focus COBOL Server.

Note: For applications created with earlier Micro Focus products or earlier versions of Visual COBOL,
note the following:

Database Access Managed applications using SQL(DBMAN=ODBC) that were compiled in
Visual COBOL 2.1 Update 1 must be recompiled in Visual COBOL 2.2.

Existing
Applications

Application executables that were compiled using earlier Micro Focus products
must be recompiled from the sources using Visual COBOL.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
4. Click Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of

Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add

or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus COBOL Server and Micro
Focus License Administration. Uninstalling only COBOL Server does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

Installing on UNIX
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System Requirements for COBOL Server for UNIX

Hardware Requirements
The disk space requirements are approximately:

Platform COBOL Server (MB) Sentinel RMS license server (MB)

POWER running AIX 281 26

HP IA 638 54

System Z running Red Hat Linux 234 28

x86-64 running Red Hat Linux 251 33

SPARC running Solaris 296 31

x86-64 running Solaris 266 23

System Z running SuSE SLES 237 28

x86-64 running SuSE SLES 252 33

Note: The installation requires extra disk space that equals the size of the product you install.

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements
Before installing this product, you must have the following software installed on your computer:

• The Korn shell is required for the licensing daemon. After the installation, if the licensing daemon does
not start, check and ensure the Korn shell is installed and then run the /var/
microfocuslicensing/bin/startmfcesd.sh script to start the daemon.

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On Red Hat 6.x, you must have the following operating system libraries installed:

glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686

Visit the Red Hat Web site for more information.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
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You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Before you start the installation, you need to set the environment as follows:

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

• The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from 
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

• JavaScript or scripting support must be enabled in your browser, so that Enterprise Server
Administration is usable. Also, active content must be allowed and not blocked.

Additional Software Requirements
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file. The following information specifies the third-party software required for each feature.

Java Compilation

• The Java Development Kit (JDK), version 1.6 (u27 or later) or version 1.7 (u05 or later), is required for
compiling Java. The JDK is downloadable from www.oracle.com. After installing the JDK, you must put
the tools.jar file for the JDK on your classpath, using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

XML Extensions

• XML Extensions has the same requirements as Visual COBOL. Both 32-bit and 64-bit versions are
available. See the Visual COBOL XML Extensions User's Guide, available from the Visual COBOL
product documentation section of the SupportLine website, for more details.

• Additionally, XML Extensions may be used in conjunction with Terminal Server.

Database Access

Before you can use COBOL Server to deploy SQL applications developed with OpenESQL, DB2 ECM, or
COBSQL, ensure any third-party software prerequisites are installed and the environment is set properly.
Refer to the your product help, Welcome > Product Information > Installing... > System
Requirements... > Additional Software Requirements > Database Access, for details.

Java Development Kit (JDK)

The Java Development Kit (JDK) is required for compiling Java.

JDK or JRE is required for compiling and running COBOL JVM applications

After installing the JDK, you need to set up your Java environment.

Installing COBOL Server for UNIX

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

12 | Installation

http://supportline.microfocus.com
http://www.microfocus.com/docs/links.asp?nx=java
http://www.microfocus.com/docs/links.asp?nx=java


Installing
These are the steps to install this product:

1. Give execute permissions to the setup file:

chmod +x setup_cobol_server_2.2_platform

2. Run the installer with superuser permissions:

./setup_cobol_server_2.2_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.

The COBOL environment is installed by default into /opt/microfocus/product-name, (COBDIR).

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_cobol_server_2.2_platform -installlocation="full path of new 
location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ],
where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file -
for example, -ESsysLog="/home/esuser/logs". The default location is /var/
mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command
line - for example, -EDadminID="esadm". The default user ID is the one that runs the
installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running on
your machine. During installation licensing is shutdown to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipsafenet option,
which skips the installation of SafeNet:

./setup_cobol_server_2.2_platform -skipsafenet
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• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file and
install Sentinel RMS server manually.

After Installing
When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing as an Upgrade
This release works concurrently with the previous version of COBOL Server, so you do not need to
uninstall it. There are two options for installing the latest version in this case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable ( /opt/microfocus/VisualCOBOL, by
default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

COBOL Server installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/VisualCOBOL"

Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.
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Installing Silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install.

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

setup_filename –silent -IacceptEULA

UNIX Installer Issues

Licensing
Daemon

If the Korn shell is not installed on your machine when you run the installer, the
licensing daemon will not be started. To resolve this after you install the product, install
the Korn shell and then run the /var/microfocuslicensing/bin/
startmfcesd.sh script to start the daemon.

License
Infrastructure
Installer

On some Solaris platforms, you can receive the following error message when SafeNet
license server needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

To resolve this issue, wait for the installation to complete and then perform the
following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

License Server You need to configure the computer hostname to ensure the license server will start
properly.

To avoid performance issues, "localhost" and the computer hostname must not both be
mapped to IP address 127.0.0.1. You should only map "localhost" to IP address
127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts
file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOL22.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.
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To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• This release uses the authorization code for the COBOL Server 2.0 release.
• The latest version of the SafeNet licensing software is required. See Software Requirements in

this document for more details.
• If you are unsure about what your licensing policy is or what sort of license you require, consult

your System Administrator or Micro Focus SupportLine to obtain a valid license.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

Licensing Information | 17



If you have an authorization code

Authorizing your product when you have an Internet connection
Note: This topic only applies if you have an authorization code.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code.

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.
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In order to authorize your product you must have the following:

• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.
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New Features in COBOL Server 2.2

ACUCOBOL-GT Compatibility
The following support has been added to Visual COBOL in this release:

Accessing data files through AcuServer

You can now access your ACUCOBOL-GT data files, both sequential and Vision files, through AcuServer.

Standard library routines

Support for the following library routines has been added:

• C$GETPID
• C$JUSTIFY
• C$LIST-DIRECTORY
• C$LOCKPID
• C$REGEXP
• C$RUN
• C$SLEEP
• C$SYSTEM
• C$TOLOWER
• C$TOUPPER
• I$IO

RM/COBOL Compatibility
The following support has been added to Visual COBOL in this release:

Subprograms

Support for the following subprograms (referred to as library routines in Visual COBOL) has been added:

• C$OSLockInfo
• C$SecureHash

recover1

The recover1 utility, RM/COBOL's indexed file recovery utility, is now distributed with Visual COBOL. Refer
to the RM/COBOL File Handling section of RM/COBOL Compatibility for details of its use.

File Handling
New features include:

• Converting and editing Vision and RM/COBOL indexed data files using the Data File tools is now
supported.
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• Access to data files (either sequential or indexed) through AcuServer is now supported.
• Access to Vision and RM/COBOL indexed data files through Enterprise Server is now supported.

Support for SOA
Restriction: This topic applies only when the Enterprise Server feature is enabled.

Visual COBOL now includes support for creating Web service and Enterprise Java Bean applications using
the Interface Mapping Toolkit (IMTK) in conjunction with Enterprise Server. If you are upgrading to this
release from an earlier version of Visual COBOL, you may need to apply for a new authorization code in
order to access the functionality - please contact Micro Focus SupportLine to receive an updated
authorization code. Note that the Visual COBOL Personal Edition license does not support the IMTK
functionality.
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

AcuCOBOL
File Handler

When using an interface of ACUFH other than MSSQL, you may experience a file
operation delay when the interface fails to connect to a database. This failed connection
also results in a memory leak. Set the environment variable MSSQL_DETACH to 1 to
avoid both issues.

ASP.NET It is not possible to run ASP.NET Web Sites or Web Services on a production machine
(one that has Micro Focus COBOL Server installed) without an additional setup. This is
because the production machine does not contain development tools such as the
COBOL Compiler. To workaround this, you need to do the following steps:

1. Precompile the site before you deploy it using the Publish Web Site command in
Visual Studio.

2. Edit the .asmx file of the Web service project or the .aspx file of the Web site and
delete the Language="COBOL" statement.

3. Edit the Web.config file with a text editor and delete the line which contains:
<compiler language="COBOL"...

4. Ensure that a .NET Server license is installed using Apptrack.

Enterprise
Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled
enterprise servers.

ICETOOL
Emulation

ICETOOL emulation for managed code is not available in this release.

Installation • On UNIX, check UNIX Installer Issues before you start the installation.
• If you are using the latest version of Java 1.7 on Linux, you might receive some

warnings when you start this product. To resolve the issue, it is recommended that
you install an earlier version of Java 1.7 and set JAVA_HOME to that.

Resource
Adapters

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may
fail with a ClassCastException. To work around this issue, you need to deploy mfcobol-
xa.rar first, then need to undeploy this file and deploy the local one, mfcobol-
localtx.rar. If there are issues deploying using the WebLogic GUI, you can use the
command line. If there are issues with this as well, try reducing the length of the
command (for example, by moving the file to a location with a shorter path).
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• .NET Compiler
• CCI Session Layer Code
• Compiler
• MF Directory Server
• MF Server Administrator (GUI)
• MFBSI
• MTO - IMS Other
• MTO - JCL MVS
• MTO - JCL System Catalog
• Open PL/I Compiler
• Open PL/I Debugger
• Open PL/I RTS
• Request Handler

.NET Compiler

Back to the list

• The use of ILSMARTLINKAGE in sub-programs is now working correctly. In previous versions, if it was
specified in a sub-program, a dynamic call of that program from another program could cause execution
failure.

2608825 (1087435)
• In managed code, the statement DISPLAY UPON SYSERR now behaves as expected. Previously, it

was behaving the same as DISPLAY UPON CONSOLE.

2589053 (1085576)
• When the PROPERTY keyword is used on a numeric edited field, the SET method now works correctly

when the program specifies DECIMAL POINT IS COMMA.

2588508 (1085560)

CCI Session Layer Code

Back to the list

• A new option, use_global_namespace, is available for the cci.ini file in the Windows %SystemRoot%
folder. If use_global_namespace is set, all the ccishared memory objects are created in a system-wide
address space, and the applications hosted by different users, including system services, can
communicate. To use this facility, edit the cci.ini file and ensure use_global_namespace is set to "yes".
[ccismem-base] # Allow interaction between users on a # single system. Using this option reduces
security as # all users will have access to the same name space. use_global_namespace=yes If the
value of this option is anything other than "yes", or if the option is missing, no change is made to the
existing behavior.

2195519 (1062800)
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Compiler

Back to the list

• The default for the NSYMBOL directive under DIALECT(ENTCOBOL) has been changed to
NSYMBOL(NATIONAL) to emulate the equivalent IBM default.

2657471 (1090355)
• To improve RM/COBOL and ACUCOBOL compatibility, the SIGN clause at a group level is no longer

applied to non-DISPLAY usage signed numeric data items within the group, just as it is not applied to
unsigned numeric data items and non-numeric data items within the group.

2549904 (1082171)
• Previously, even though no code was generated, the Compiler allowed the ON EXCEPTION and NOT

ON EXCEPTION phrases in the DISPLAY statement in formats that do not allow these phrases. As a
result, if the DISPLAY statement was in the ON EXCEPTION phrase of another statement, the NOT ON
EXCEPTION phrase would bind incorrectly with the DISPLAY statement instead of with the intended
containing statement - for example, ACCEPT or CALL.

MF Directory Server

Back to the list

• The mfds command line option for exporting registered Enterprise Server definitions to an XML file now
supports the "*" option. This exports all registered servers rather than a specified server. Multiple server
definitions are now exported into the target directory and saved into a file with the default name
ALLSERVERS.xml. The import option now also supports the import of multiple server definitions from a
single XML file.

2641890 (1088838)
• mdump now supports a new option, -e, to help you query the Security Manager configuration details.

The possible values of the option are: "1" - shows security configuration that applies to any returned
enterprise servers; "2" - shows security configuration for MFDS and the default Enterprise Server
security configuration. This requires MFDS version 1.15.00 or higher; "3" - returns the properties of all
configured external Security Managers.

2487164 (1081693)

MF Server Administrator (GUI)

Back to the list

• When adding a user to an external security manager, you can now include a password expiry time in
the Advanced Configuration section of the Add New User wizard in Enterprise Server Administration.
The field value is specified using generalized time format (YYYYMMDDHHMMSS.0Z), and can be used
by the MLDAP ESM for calculating whether a user's password has expired and requires updating. This
value may only be specified using this page when adding a user. You need to use an external directory
services configuration tool to edit it.

2562118 (1083203)

Request Handler

Back to the list

• A problem that caused BIS to create log files in a directory named C:\ProgramData\AcuCorp\BIS
\LogFiles was fixed. BIS no longer creates log files unless specified and the BIS logging service is now
disabled by default. To enable it, you need to use the following global environment variable:
BIS_LOG=[ OFF | ON | <directory> ] Where the values are:

• OFF - disables logging (the same as if BIS_LOG is not specified or is left blank)
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• ON - enables logging and directs the log files into the default location, which must not be read-only.
• <directory> - enables logging and directs the log files into the specified directory. The user must

ensure that the BIS request handler has write rights for this directory. The directory must be an
absolute path or network path. If the specified directory does not exist, BIS will attempt to create it.
The containing directory must exist.

The BIS_LOG variable is only examined when the BIS application pool is started or recycled. After
setting or changing BIS_LOG, IIS must be restarted in order for the variable to take effect.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• .NET Compiler
• .NET ESQL Support
• .NET RTS
• Adis
• BIS Service Engine
• CAS (COBOL App Server) General
• CAS Security
• CAS XA Switch modules
• CCI TCP/IP
• Compiler
• Cob/Cbllink/Cblnames (32-bit PC)
• Documentation
• File Handling - External File Handler
• File Handling - Fileshare
• JVM - Compiler
• JVM - RTS
• MF Common Client
• MF Communications Server
• MF Directory Server
• MVS REXX Emulation
• NCG
• RTS
• Setup Issues
• Setup Issues (UNIX)
• SQL: DB2 ECM
• SQL: OpenESQL
• Vision File System
• XML Extensions
• XML syntax support runtime

.NET Compiler

Back to the list

• It is now possible to query data items during debugging for programs containing multiple entry points,
compiled with the directive PERFORMTYPE"OSVS".

2663738 (1090935)
• The correct calling conventions are now used for programs that have multiple platform invokes with

different calling conventions.

2660948 (1090751)
• Accessing an ILSMARTLINKAGE class built for a group containing an OCCURS DEPENDING ON item

no longer causes unexpected results, as it now uses the maximum length for the OCCURS
DEPENDING ON item within the property access methods for the group.

2654127 (1090119)
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• A SEARCH statement where the table name contains DBCS characters now compiles to managed
code successfully.

2652827 (1089896)
• When compiling managed COBOL, a move from an alphanumeric field to a numeric property no longer

causes an error. (This was an error that was introduced in Visual COBOL 2.1 update 1.)

2651658 (1089833)
• Incorrect code is no longer produced when creating WCF services.

2649616 (1089641)
• 'Illegal format: literal' errors are no longer generated when building and running a website.

2645733 (1089290)
• Incorrect control flow no longer occurs when an EXIT PROGRAM statement is in a paragraph by itself,

and that paragraph is performed from elsewhere in the program. Previously, this could result in the
EXIT PROGRAM being ignored.

2642765 (1089164)
• When debugging .NET COBOL on a 64-bit system, the result field is now updated correctly when you

step over a divide operation.

2642169 (1088841)
• Previously, if a .NET managed program called a C++ method, where one of the parameters was

marked with the IsLong modifier, the code failed at run time with a "method not found" error.

2615417 (1088095)
• The Form Designer is now working correctly when PIC 1 data items containing boolean literal values

are inserted into a working-storage section associated with a Windows form.

2612621 (1087910)
• Previously, when a callfh directive targeted a method expecting more than the normal two parameters,

you received a system error at compile time.

2611093 (1087662)
• Stepping over an IF statement while debugging now works as expected. Previously, it could leave the

cursor pointing at the first statement following the IF, even though the associated conditional expression
evaluated to false.

2610824 (1087679)
• A new directive, ILSHOWPERFORMOVERLAP, which identifies those procedures that form part of an

overlapping perform range is now available.

2607319 (1087299)
• The ATTACH and DETACH statements no longer produce compiler errors when referencing an event

declared in a different class.

2604429 (1086973)
• A SORT statement used in an object method, where the program did not have OBJECT/END OBJECT

markers, could result in an "index out-of-range" exception at run time.

2596409 (1086418)
• In managed code, some COBOL numeric fields are now optimised to 32-bit or to 64-bit binary fields,

regardless of their definition in the COBOL source. This means that fields defined as DISPLAY or
COMP-3, for instance, which do not form a part of a group, may be stored as binary fields. The
Compiler inserts the required code to make the behavior of these fields the same as if they had not
been optimised.

2595775 (1086432)
• In .NET COBOL, when HOSTNUMCOMPARE is specified, a numeric item containing a level 88 with

multiple values no longer produces invalid code.

2595331 (1086088)
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• The use of EXTERNAL files in class programs compiled for managed code no longer leads to invalid
code generation.

2595177 (1086071)
• When defining a field using the syntax: 01 s1 type String. an EVALUATE statement using the field as

the subject now executes the correct control flow.

2594906 (1086055)
• The use of host variables defined as type DateTime no longer produce spurious compiler errors.

2594156 (1085997)
• An error that could cause a MissingMethodException for managed programs compiled with

charset(ebcdic) has been fixed.
• When a COMPUTE target had more than 18 significant digits and the COMPUTE expression included

division, the decimal scaling could be lost, producing incorrect results.
• The error reporting for forward references and ambiguous references has been enhanced.
• In managed COBOL, a statement of the form "set string-type to interface-type", where string-type is an

item of type string and interface-type is an item of some interface type, was producing invalid code.
• Spurious errors relating to indexed file keys are no longer produced as a result of using implicit local

declaration.

.NET ESQL Support

Back to the list

• Previously, OpenESQL incorrectly handles Oracle NOWAIT, WAIT n and SKIP LOCKED cursor options
when SQL(TARGETDB) was set to ORACLE.

2649989 (1089640)
• The OpenESQL preprocessor now accepts SQL(DATE=ODBC) and SQL(TIME=ODBC).

2641087 (1088749)
• The behavior of various cursor types in different usage scenarios is now documented, showing how the

product behavior is now more consistent across different database types for error detection and
reporting.

2614802 (1088009)
• Previously, a nullable host variable in a stored procedure call might have generated an invalid call

statement.

.NET RTS

Back to the list

• Using binary floating-point items on a machine with a non-English locale no longer produces errors.

2657599 (1090407)
• The RuntimeServices Add() method for .NET COBOL no longer gives an exception for some instances

of COBOL classes.

2642836 (1088926)
• Using "DIVIDE ... GIVING quotient ROUNDED" where "quotient" evaluates to zero no longer causes an

exception.

2641108 (1088761)
• An error in JVM COBOL converting the result of a floating point expression to a fixed point expression

has been fixed.

2610381 (1087558)
• Computation of fractional exponents in .NET managed COBOL has been improved and is now much

faster.
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2594740 (1086047)

Adis

Back to the list

• Statements of type "DISPLAY SPACES AT LINE... POSITION... SIZE..." now only clear the screen at
the specified coordinates and for the specified size.

2644054 (1089103)
• The Compiler and ADIS now support RM/COBOL ACCEPT and DISPLAY behavior, including when the

Compiler DIALECT(RM) directive and the RM2VCOB configuration in ADISCTRL are both used.

2616898 (1088510)

BIS Service Engine

Back to the list

• An issue where XML payloads larger than 49152 bytes were being presented to the COBOL program
as an empty request has been fixed.

CAS (COBOL App Server) General

Back to the list

• casgate no longer crashes when it receives a shutdown request from MFCS.

2657261 (1090327)
• When an MFCS process terminated while it was processing an EZASOKET function for an application,

the SEP remained in a waiting state indefinitely. Recovery processing now dispatches the SEP with a
TERMAPI.

2653313 (1090061)
• EZASOKET applications are now tied to a single comms process for the life of a task. Previously, in the

event of termination of a comms process (if the process was not being used by an active EZASOKET
application), recovery would cause any active EZASOKET applications to dispatch the new comms
process on the next EZASOKET call (which would then fail) rather than the one it was already using.

2653313 (1090060)
• When an enterprise server was processing a very large number of JCL jobs for the same class, a job

could be locked for dispatch in SYSZJOBD forever.

2617413 (1088420)
• The EZ sockets SELECT and SELECTEX APIs now duplicate mainframe behavior in ignoring mask bits

that do not correspond to allocated descriptors. This means, for example, that SELECT can be passed
as a mask set to -1 (all bits set) to refer to any sockets the application has open.

2609555 (1087715)
• A problem with submitting jobs when "Local ES Security enabled" is checked for mfuser on the Users

page in ESMAC has been resolved.

2605873 (1087287)
• Jobs active during shutdown are moved back to the input queue when the server restarts.

2588701 (1085584)
• Previously, when retrieving the spool information, the text of some error messages has been truncated.

2582713 (1085017)
• Logging has been added for the resource managers to facilitate recovery from failures that leave the

resource managers such as DB2 and MQ with in-doubt transactions. You only need to log if the
resource manager switch modules are configured to respond to xa_recover() calls. Logging may affect
the performance so you can disable it as follows - edit the server from the Enterprise Server
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Administration, click the General tab and type the following in the Configuration Information text box:
[ES-Environment] ES_XA_LOG_SUPPRESS=Y

2582570 (1085539)
• If you define an XA resource definition in MFDS for MQSeries, you must deselect IBM MQ in the SIT

definition in ESMAC, otherwise you will get a -5 error when the XA Switch is used.

CAS Security

Back to the list

• A "redundant" or "high-availability" mode is now available in the Enterprise Server External Security
Facility. It enables you to configure multiple equivalent Security Managers and let processing continue
as long as at least one Security Manager is available. To enable this feature, add the following to the
configuration text area for the security configuration (either in the default Enterprise Server Security, the
MFDS Security, or on the Security tab for a specific enterprise server): [Operation] redundant=yes

2646298 (1089343)
• Previously, when using IMS with LDAP-based security, the system could sometimes stop processing

requests for four minutes, and then issue a series of messages in the console log to indicate that
threads had timed out waiting for a thread lock. The system would then generally recover and start
processing again.

2640581 (1089108)
• The fix for this RPI addresses the following specific situations:

1. Installation with an ESM that is not case sensitive for user IDs (for example - when sysad, SYSAD,
SysAd and other case combinations are all recognized by the ESM as the same user).

2. Installations where all user IDs are of a the same case - either uppercase or lowercase.
3. Installations where the user IDs are of mixed case and you would like to suppress any additional

ESM authorization attempts for keying errors.
4. Only ESM-backed security is affected.

You can now use the environment variable "ES_ESM_IDPW_CASE=xy" where "x" = user; ID case and
"y" = Password case. The values for "x" and "y" are:

• U = Always uppercase
• L = Always lowercase
• M = Mixed case and case sensitive

When this environment variable is set, Enterprise Server will only make one attempt to identify a user
presenting the user ID and password as is (M), folded to uppercase (U) or folded to lowercase(L). If this
environment variable is not set, the legacy Enterprise Server behavior will be used. For the legacy
behavior for CICS, the User ID and the password are used as supplied possibly filtered by the
uppercase translation configuration of the sign-on transaction. For the legacy behavior for ESMAC and
IMS you have the following sequence - first, the user ID and password are used as supplied. If the
authentication fails, the User ID is folded to uppercase and used again. If this fails as well, both the user
ID and the password are folded to uppercase and the used.

2640427 (1088819)
• For Enterprise Server External Security, the MLDAP ESM Module now supports retrying the connection

to the LDAP server if it fails to connect. This provides some fault tolerance if the server is not
immediately reachable. See the MLDAP ESM Module documentation for more information.

2619088 (1088485)
• When using an External Security Manager (ESM), an IMS printer no longer passes authorization

incorrectly when it is unknown to the ESM.

2617526 (1088978)
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• When the LDAP-based security has a long timeout (over four minutes) configured for LDAP operations,
the ESF Manager now increases the timeout for thread locks accordingly so thread locks do not expire
prematurely while the MLDAP ESM Module is waiting for a slow LDAP server.

• In Enterprise Server's External Security Facility, the MLDAP ESM Module normally attempts to set a
user's failed-login count and last-login-time if the user class includes the associated LDAP attributes
(microfocus-MFDS-User-LoginAttempts and -LastLoginTime). You can now disable this from the
Security Manager configuration. See the documentation for the MLDAP ESM Module for more
information.

• The cas-to-ad utility, which is used when initially configuring LDAP-based security for Enterprise Server,
now picks up the correct path for the default location of the CICS resource definition file (dfhdrdat).

CAS XA Switch modules

Back to the list

• If a ROLLBACK is already in operation when an XA ROLLBACK is requested, Enterprise Server sees
the rollback as being successful.

2653121 (1089931)
• The XDB XA switch module was updated to add a missing variable definition which prevented

compilation.

2638370 (1088599)

CCI TCP/IP

Back to the list

• CCITCP now supports more than 4000 clients per server process on UNIX systems. CCITCP's memory
consumption with large numbers of clients should also be reduced, compared with previous releases.

2589460 (1089134)
• CCI has been extended to allow the user to tune the content and location of first failure error messages

produced by CCI. This is controlled by the errlog_path option in the cci.ini configuration file.

2083845 (1053206)

Compiler

Back to the list

• Programs with data names containing certain DBCS characters now compile as expected. Previously,
they would incorrectly report error message "COBCH0005 User-name not unique.".

2663436 (1090882)
• VALUE clauses on THREAD-LOCAL data items are now always correctly initialized on a per thread

basis.

2659874 (1090647)
• Debugging with Expression view expanded to show many qualification levels of a data record no longer

causes the IDE to crash.

2659532 (1090682)
• A MOVE of a numeric literal to a JUSTIFIED RIGHT data item now executes as expected.

2658757 (1090641)
• The MOVELENCHECK directive now also includes checking when the source item is an alphanumeric

literal.

2656595 (1090311)
• When compiling with DIALECT"ACU", a comparison between a numeric item and the figurative

constant NULL now works as expected.
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2653033 (1089923)
• Comp-1 data items are now processed correctly under DIALECT"RM". Previously, they were treated as

binary floating point items.

2652327 (1089892)
• Preprocessors now work as expected with the DIALECT"ACU" compiler option.

2649324 (1089577)
• The DIALECT(RM) directive now sets PERFORM-TYPE(RM).

2647147 (1089366)
• Large EXEC statements containing DBCS characters now compile without error.

2645584 (1089204)
• List file output with the DATAMAP directive is now shown correctly for SJIS data names.

2643308 (1088962)
• The DBCS hyphen character x"817C" is now treated as occupying the correct number of column

positions, and so prevents spurious compile errors for comments in Area C.

2642431 (1088863)
• Programs using ACUCOBOL-GT index names now execute as expected.

2641124 (1088755)
• A VALUE clause on a national data item that specifies a figurative constant now works as expected.

2640826 (1088820)
• An "out of memory" error when compiling ACUCOBOL-GT programs with both COPY REPLACING and

REPLACE statements has been fixed.

2640304 (1088671)
• $DISPLAY of SJIS characters now works as expected.

2640050 (1088644)
• Tab characters on the same line as DBCS characters no longer cause margin issues.

2638792 (1088607)
• The maximum number of extensions supported by the COPYEXT directive has been increased to 25.

2618274 (1088353)
• Literals assigned to DBCS data items are now checked for valid content.

2618240 (1088339)
• When running under RM/COBOL or ACUCOBOL-GT emulation, appropriate declaratives are now

executed for an unsuccessful DELETE FILE operation.

2616717 (1088313)
• The emulation of RM/COBOL has been improved regarding the default encoding of numerics types.

2607368 (1088045)
• The error message for when special register names are used as data-names has been improved.

2599694 (1086646)
• A qualified reference to a paragraph in another section followed by an unqualified reference to the same

paragraph now compiles without error.

2598461 (1086498)
• Display statements are now displayed correctly when using the window1 preprocessor.

2591903 (1085826)
• A syntax error is now produced if you attempt to use a data item with more than 18 numeric positions in

extended ACCEPT/DISPLAY syntax.

2590649 (1085688)
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• The COPY statement no longer requires Katakana characters in a copybook's name to be enclosed in
quotation marks in order for the copybook to be found.

2582689 (1085009)
• With regards to file handling, the DIALECT(RM) compiler directive now better emulates the default

behavior of the latest RM/COBOL product.

2582096 (1084955)
• An error with EXTERNAL files where the fd name is the same as the name of an OS function (e.g. sin

or strcpy), which caused an rts error 114, has been fixed.

2492339 (1077479)
• An error in ADD statements with multiple targets, where one of the targets has a subscripted subscript,

has been fixed.

2189318 (1062255)
• Error messages 'RTS226 External file definition inconsistent' and 'RTS227 External data definition

inconsistent (Fatal)' have been enhanced to give additional information.

2188868 (1062214)
• Parsing and consistency checking of the FOREGROUND-COLOR attribute in DISPLAY statements has

been improved.
• The Compiler no longer crashes when processing the USE Compiler directive and the specified

directive file does not exist.
• Under a Shift-JIS locale, you can now successfully compile a program containing tilde characters.
• EXEC statements are now subject to the action of REPLACE statements (INCLUDE names excepted).
• An INSPECT statement with both 'TALLYING .. FOR TRAILING ..' and 'REPLACING TRAILING ..'

syntax now compiles successfully and executes as expected.
• The CHANGE-MESSAGE and HIDE-MESSAGE directives have been enhanced to allow non-severe

SQL and CICS errors to be configured (their severity changed or completely suppressed). This can be
achieved using the error message's 2-character sub-component prefix; for example, CHANGE-
MESSAGE(ES1000 N). If no prefix is specified, CH is assumed.

• You now receive a warning when you use a TYPEDEF-NAME as a parameter for the PROCEDURE
DIVISION header of an ENTRY statement, except for external programs or program prototypes where
this syntax is legal.

• The Compiler no longer crashes with an RTS114 error after finding multiple Report Writer syntax errors.
• A error processing a bitwise logical expression that has a subscripted operand where the subscript is an

arithmetic expression has been fixed.

Cob/Cbllink/Cblnames (32-bit PC)

Back to the list

• CBLLINK no longer gives an error when an object file is specified in a fully qualified path containing a
dot.

2605052 (1087384)

Documentation

Back to the list

• The documentation was not clear about the range of acceptable values of EX_XA_????_NB_RETRIES
or the consequent system behaviours. This has been corrected.

2593300 (1085893)
• The documentation has been amended to alert users that under certain conditions, a dynamic binding

error is possible

2553077 (1082557)
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• You no longer need a 64-bit enterprise server in order to communicate with Microsoft BizTalk Host
Integration Server on a 64-bit machine.

2614060 (1087978)
• The documentation has been updated so that the help page more accurately reflects the ESMAC

screen.

2611733 (1087753)
• The product documentation now includes information about the ES_JESYSMSG_OUTPUT

environment variable.

2604533 (1087004)
• The documentation has been updated to clarify the effect of escape characters on path names.

2594224 (1086013)
• The CPMT transaction no longer supports the CEDF or NOCEDF functions.

2527592 (1089531)
• The documentation has been updated to remove references to ERRORLEVEL in UNIX environments.

2610423 (1087575)
• The documentation has been updated to provide more information about the MFJAMS LISTCAT

command.
• When invoking MFSORT from the command line, the maximum length of the command is 1024

characters. Characters after this limit are ignored, and if this truncation causes an invalid/incomplete
command, an error is produced.

File Handling - External File Handler

Back to the list

• For SORTIN, all data sets in a concatenation must use the same RECFM - either all fixed-length or all
variable-length. Also, if using fixed-length records, LRECL must be set the same for all data sets.

2654517 (1090095)
• A COMMITFLUSH no longer causes file corruption. Previously, corruption was possible with

COMMITFLUSH on when a process, having done only a rewrite that changes non-key data, is
committed after another process has altered the files size.

2652378 (1090281)
• The RM RECOVER1 utility is now distributed with Visual COBOL in case RM indexed files need to be

recovered or rebuilt.

2650917 (1090175)
• Support has been added for the ASSIGN TO PRINT syntax when accessing RM/COBOL data files.

Specifically, BEFORE ADVANCING <count>, AFTER ADVANCING <count>, BEFORE ADVANCING
PAGE, and AFTER ADVANCING PAGE now work correctly and produce the same print file contents as
they do in RM/COBOL.

2649809 (1089792)
• The RM/COBOL configuration option

RMFM_RUN_INDEX_FILES_DEFAULT_FILE_VERSION_NUMBER 2 now correctly creates a version
2 RM/COBOL indexed file.

2649414 (1089679)
• A SORT action no longer fails due to an illegal filename when the SORTTEMP file is specified to be an

RM file using EXTFH.CFG.

2648865 (1090292)
• File names containing embedded spaces now work correctly in XML Extensions.

2648306 (1089486)
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• The correct file status "23" is now stored in the file status data item, which will cause the proper
INVALID KEY condition action for REWRITE RANDOM or DELETE RANDOM I/O operations on an
RM/COBOL data file.

2648182 (1089461)
• A WRITE or REWRITE operation on a fixed record length RM/COBOL or ACUCOBOL-GT file no longer

generates an erroneous 44 error after a READ of a short record.

2647143 (1089369)
• DELETE and REWRITE operations on an RM/COBOL indexed file with DYNAMIC access and where

the prime key allows duplicates now work correctly, meaning that the behavior matches RM/COBOL,
where the operation behaves like sequential access and deletes or rewrites the current record.

2646274 (1089289)
• When opening an RM/COBOL data file for input, a READ WITH LOCK after a READ WITH NO LOCK

no longer returns an erroneous 99 (record locked) error. This matches RM/COBOL behavior for a file
opened in the input mode.

2644830 (1089726)
• When accessing RM/COBOL data files, a file status of 04 is correctly returned where appropriate.

2616717 (1088310)
• When accessing RM/COBOL data files or calling C$RERR, file statuses '44,03', '44,04', and '44,07' are

correctly returned where appropriate.

2616717 (1088465)
• When accessing RM/COBOL data files or calling C$RERR, file status '47,01' is correctly returned where

appropriate.

2616717 (1088467)
• When accessing RM/COBOL data files or calling C$RERR, file status '48,01' is correctly returned where

appropriate.

2616717 (1088468)
• When accessing RM/COBOL data files or calling C$RERR, file statuses '93,02' and '90,05' are correctly

returned where appropriate.

2616717 (1088469)
• A file status of 90,05 is now correctly displayed as 90.

2616717 (1088449)
• C$RERR now reports a meaningful 30,22,nnnnn error, where nnnnn is the Micro Focus extended

status, when the File Handler diagnoses an operation error on an RM/COBOL data file.

2616717 (1088470)
• File Handler now converts the charset of all instream data in a concatenated dataset to that of the

calling program.

2606382 (1087212)
• The file locking for VB files with DISP=SHR has been removed. It is now the user's responsibility to

ensure that other users do not update the file at the same time.

2605857 (1087302)
• EXTFH configuration options specified under the FOLDER tag now work correctly with UNIX files when

they are specified with an absolute path in the SELECT statement of a COBOL program.

2594733 (1086089)
• Concatenating multiple SYSIN DD statements now works correctly.

2590465 (1085905)
• File corruption no longer occurs when you make two rewrites of a record in the same transaction, where

the first rewrite changes an alternate key and the second rewrite changes it back again.
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2576793 (1084780)
• CTF tracing no longer defaults to showing CTF handles as errors. CTF tracing for handles now only

appears for DEBUG and ERROR levels.

2566161 (1083551)
• If the DDname is missing from JCL, the value of COBDATA is not used to search for a file.

2559292 (1084935)
• The rebuild help message file has been updated to correct a typo.
• Fileshare now supports the ACU and RM file formats.

File Handling - Fileshare

Back to the list

• SORT no longer abends if the SORTIN file is a Fileshare file.

2653753 (1090002)
• A commit-prepare now returns non-zero error code if the Fileshare server is not running.

2637773 (1088492)
• If the Fileshare server crashes before a commit or a rollback in the two-phase commit, the transactions

before a commit-prepare are now committed while recovering the file.

2637773 (1088493)
• Byte-stream routines called from Fileshare clients now work correctly with a 64-bit Fileshare server.

2607314 (1088601)

JVM - Compiler

Back to the list

• Previously, a program using a MAX OR MIN function with an ALL parameter was generating bad code
when compiled for JVM.

2647112 (1089359)
• Previously, you could receive some warnings for calls to the RM library routine C$GetEnv.

2601487 (1086710)
• When compiling JVM COBOL, if the PERFORMTYPE directive is not set to the default value of mf, very

large programs sometimes do not compile. In such cases, 'COBCH1633 - Procedure division too large
or complex - try using performtype(mf)' is displayed. Compiling with performtype(mf) normally fixes the
problem.

2581224 (1084860)
• In Windows environments, if a COPY statement specified a file name that was not in quotation marks,

or did not include the full extension, then setting a breakpoint in that copy file was not always
successful.

2577765 (1084637)
• Copy statements that reference a file whose path contains spaces no longer cause errors.

2577765 (1086750)
• Previously, the JVM Compiler did not recognize COBOL static inner classes (that is - nested classes

without a SHARING PARENT, or nested classes produced using ILSMARTNEST).

JVM - RTS

Back to the list
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• When using JVM COBOL with Apache Tomcat, you no longer see warning messages from the
org.apache.catalina.loader.WebappClassLoader checkThreadLocalMapForLeaks class relating to
classes in the package com.microfocus.cobol and below.

2612595 (1088144)
• When creating a debug configuration for a JVM COBOL application, superfluous classes are no longer

listed on searching for a Main class.
• Previously, when a thread called a subprogram with thread-local storage it might have intermittently got

reset when creating many threads quickly.

MF Common Client

Back to the list

• A problem with the Micro Focus Common Client not supporting 64-bit COBOL programs on UNIX and
Linux has been fixed. This enables ECI functionality for 64-bit COBOL programs, and may correct
issues with certain other features such as Web Services clients.

2642116 (1088854)
• When there are multiple directories configured in mf-client.dat, the service deployment tools (such as

imtkmake) and the IDE features now correctly scan all directories for deployment destinations and not
only the first one.

MF Communications Server

Back to the list

• In EZASOKET/EZACICAL applications, the "reserved" portion of the socket-address information
returned by API calls (such as GETSOCKADDR and GETPEERADDR) is now set to low-values, for
improved mainframe compatibility.

2659699 (1090549)
• You no longer receive a run-time system error when an invalid IMS Connect message is received with a

missing end-of-message indicator.

2649746 (1089727)
• A problem causing IMS Connect conversations to an enterprise server to hang has been resolved.

2645771 (1089247)
• For SSL-enabled listeners in Enterprise Server, MFCS now offers the option of setting SSL keyfile

passphrases using a user exit module. For instructions and a sample module, contact Micro Focus
SupportLine.

2641670 (1088950)
• Intermittent failures in the CICS Web Interface servers that send chunked responses have been fixed.
• The SO_LINGER socket option in CICS sockets (EZASOKET / EZACICAL) now works correctly.

MF Directory Server

Back to the list

• In the Enterprise Server Administration HTML GUI, clicking "Update All" on the Security Manager List
page while an enterprise server instance using external security was started would cause the MFDS
process to terminate.

2654069 (1090069)
• The MFDS XML import command line option correctly sets the value of the listener's SSL client

authentication option on import.

2653699 (1090115)
• The MFDS command line options to export or import server configuration data when using an external

Security Manager now work correctly.
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2652779 (1089981)
• If the custom configuration text for an Enterprise Server instance was larger than 4K and the "Create

XML repository copy" repository option was selected or, if the server configuration was exported in XML
format, the MFDS process could terminate.

2650330 (1089683)
• The MFDS -x and -g command line options for creating and importing Enterprise Server instance

configuration in XML format can now be run against an MFDS process running on a specific TCP
address and port by using the CCITCP2 and CCITCP2_PORT environment variables.

2646427 (1089303)
• The correct details for Enterprise Server "MSS Inter-System Communication" conversation type

listeners can now be exported and imported using the MFDS XML export/import feature.

2644237 (1089091)
• The "Directories" link in the Enterprise Server Administration GUI did not function correctly based on the

configured Security Manager permissions for a logged on user.

2583624 (1085073)
• When you use casstart from the command line to start an enterprise server instance that appears as

"Not Responding" in the Enterprise Server Administration, the status log for that server is now cleared
when the server reaches "Started" state.

2570318 (1086170)

MVS REXX Emulation

Back to the list

• The REXX engine previously assumed that all hexadecimal strings represented EBCDIC characters.
This resulted in the X2C built-in function producing an incorrect result when a hexadecimal string
representing ANSI data was used. The MFREXX_CHARSET environment variable can now be used to
indicate whether the REXX engine should use EBCDIC or ANSI when working with hexadecimal strings
or performing string comparisons.

2647920 (1089596)
• Trace options set in a parent procedure are now propagated to a CALLed internal procedure.

2612317 (1087818)
• Execs residing in temporary datasets allocated to SYSEXEC or SYSPROC no longer sometimes fail to

load.

2579785 (1086478)
• The LASTPOS function no longer returns an incorrect result if the 'start' parameter value exceeds the

length of the 'haystack' parameter.

NCG

Back to the list

• You no longer receive an RTS 114 error when stepping EXEC SQL statements in debug mode.

2611568 (1088003)
• A bug in "display ... upon environment-name" with the [NOT] ON EXCEPTION clause has been fixed.
• A bug that affected querying linkage items in a program that has parameters in working-storage has

been fixed.

RTS

Back to the list

38 | Resolved Issues



• Using the CBL_EXEC_RUN_UNIT library routine to repeatedly execute non-COBOL processes no
longer causes a 'COBRT105 Memory Allocation Error' error to be produced.

2651531 (1090239)
• The library routine C$OSLockInfo now works correctly when used in a program compiled with the

DIALECT(RM) directive.

2643661 (1089044)
• The RANDOM intrinsic function, when compiled in a program using the HOSTNUMMOVE directive, no

longer produces a runtime error if the argument is a literal or a numeric expression.

2596268 (1086174)
• Dynamic memory allocations using the CBL_ALLOC_MEM call are no longer limited to 2Gb on 64-bit

processes.

2513886 (1079960)
• On Windows, if an error occurs when creating a coredump file, then a message box is no longer

displayed for core_on_error settings greater than 127.

2509666 (1079870)
• Reading from STDIN has been enhanced when STDIN is being redirected from a file or from a pipe line

on UNIX. It now automatically reflects the file type without the need for you to use any runtime tunables.
The record size line sequential files return is now the size of the data that is actually read. The full
record size is now read for record sequential files or when you use CBL_READ_FILE.

2468412 (1075670)
• When using the kterm terminal emulator, any new terminal Windows created by COBOL will now be

kterm, in preference to xterm. By default, it will use ShiftJis kanji mode and 16 point fonts but these can
be overridden by setting the COBTERMOPTS environment variable. For example, to use EUC kanji
mode and 14 point fonts, use: export COBTERMOPTS="-fn a14 -fk k14 -km euc"

Setup Issues

Back to the list

• The Start and Stop scripts for mfcesd and lserv have been improved for handling the possible states
that services and system files may be in.

2657001 (1090384)

Setup Issues (UNIX)

Back to the list

• startmfcesd.sh has been updated and no longer includes /tmp/mfcesclient* which it starts up. for i in
`ls /tmp/mfcesclient* 2>/dev/null` do rm -rf $i done If no files are present, remove command is skipped.

2657021 (1090386)

SQL: DB2 ECM

Back to the list

• A required file for the DB2(GEN-SQLCA)directive was missing, causing the directive to work improperly.

2659056 (1090501)
• The DB2 pre-compiler now saves or restores the RETURN-CODE special register so executing EXEC

SQL statements no longer affects that register.

2655173 (1090353)
• Previously, the DB2 preprocessor sometimes incorrectly defined the number of host variables to use for

a singleton SELECT when a group host variable was redefined using FILLER.

2613602 (1088069)
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• Previously, the DB2 preprocessor would not generate calls to a system program unless it was linked in.

2611937 (1087736)
• Previously, the DB2 preprocessor might incorrectly flag indicator arrays as invalid.

2546456 (1088155)

SQL: HCO for SQL Server

Back to the list

• Previously, the SPD Generator tool could generate invalid COBOL parameter names if no parameter
name was pecified and the parameter type was DECIMAL.

2664672 (1091009)
• Some thread safety issues that occurred in SQL run-time allocation under load have been resolved.

2658581 (1090459)
• The performance of forward-only, read-only cursors in SQL CLR stored procedures has been improved

and a new Compiler directive, SQL(OPTION=OPTIMIZESPCURSORS), has been added to provide
additional control.

2644905 (1089182)
• When SQL(DETECTDATE) is used with SQL(DIALECT=MAINFRAME), and the mainframe time format

is ISO, the second component of the time value must be present. This is to avoid ambiguity and
unwanted conversion of simple numeric character strings.

2641203 (1090111)
• Under HCOSS, SQL error messages returned from calls to DSNTIAR did not always get translated to

EBCDIC when executing the application in that mode.

2615782 (1088148)
• There are new directives, SQL(OPTION=SQCLRTRANS) and

SQL(OPTION=SPCOMMITONRETURN), that resolve some issues with stored procedures that expect
COMMIT and ROLLBACK to behave the same as mainframe DB2.

2611786 (1087718)
• You can now use DISPLAY statements with COBOL stored procedures for diagnostics in the same way

as with applications, when you set the SQL(OPTION=SPDISPLAY) directive.

2598617 (1086941)
• Previously, after a FETCH NEXT ROWSET statement, the number of rows returned was incorrectly

reported in SQLERRD(3).
• Dynamic SQL statements executed by EXEC SQL EXECUTE IMMEDIATE are now correctly converted

to T-SQL when the SQL(DIALECT=MAINFRAME) directive is set.

SQL: OpenESQL

Back to the list

• Previously, the OpenESQL runtime did not work correctly with the unixODBC 2.3.1 and later ODBC
Driver Managers on AIX platforms.

2658290 (1090583)
• Using a java.math.BigDecimal host variable as an input parameter to SQL statements caused an

ORA-17041 error.

2652362 (1089847)
• Previously, when using OpenESQL for ADO.NET, an SQL-CODE error occured when a query timeout

was set from a host variable.

2650030 (1089675)
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• Previously, OpenESQL threw an exception while attempting to set a default JDBC login timeout at
connect time.

2647801 (1089421)
• When using the Progress Oracle ODBC driver, the OpenESQL runtime incorrectly reported a failure for

a successful INSERT when a successful INSERT was followed by a failing INSERT.

2646958 (1089336)
• OpenESQL now accepts EXEC SQL DECLARE x STATEMENT END-EXEC statements, where x is a

dynamic SQL statement name. This statement has no effect but is accepted for compatibility with other
ESQL SQL dialects.

2643884 (1089076)
• When using SQL Native Client or SQL Server Native Client ODBC drivers, the PIC N(xx) USAGE

NATIONAL host variable caused an error when used with the NVARCHAR(MAX) SQL Server data
type.

2601192 (1087619)
• When executing code compiled for the JVM, if the run-time system encounters a duplicate symbol, it

now reports an RTS119 error, "the symbol is not unique".

2598694 (1086469)
• Previously, the precompiler incorrectly reset run time information in large Object-Oriented applications

that had SQL statements across multiple methods which resulted in incorrect SQL runtime errors.

2597319 (1086681)
• When compiling Oracle applications and using SQL(CHECK), errors were reported for SELECT

statements only. This has been corrected to report errors for all statements.

2566933 (1083631)
• You no longer receive an internal buffer error message when compiling OpenESQL applications under

an MBCS UTF8 locale.
• EXEC SQL DESCRIBE or PREPARE INTO now return the correct sqltype for VARCHAR columns

when the SQL(OPTION=DESCRIBEVARCHAR) directive is used. The SQL(DATE) and SQL(TIME)
directives now apply to date and time host variables that are declared with SQL TYPE as well as with
PIC X.

Vision File System

Back to the list

• RMFM now correctly generates 04,05 (and 04,06) statuses and the file status variable contains 04.

XML Extensions

Back to the list

• A compiler error when processing XML extensions with dialect(rm) set has been fixed.

2589841 (1085641)
• Previously, in native code, XML Extensions treated negative literals (such as in the value of a name/

value pair for XML SET XSL-PARAMETERS) specified as parameters in native code as a large positive
literal. It now correctly treats them as negative literals.

XML syntax support runtime

Back to the list

• Block comments in XML instance documents no longer cause a 201 parsing error.

2618943 (1088554)
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• The XML preprocessor now generates correct output for the COUNT IN clause.

2596137 (1086285)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The WebSync service, where you can download fixes and documentation updates.
• The Knowledge Base, a large collection of product tips and workarounds.
• Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) -
a tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
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2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2013. All rights reserved.
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